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Maybe it’s through years of watching apocalyptic 
movies, but there’s something about the term 
‘artificial intelligence’ that sends shivers down the 
spine. But when it comes to editing photos, AI is 
an exciting new direction (barring a few caveats). 
Find out about the top Photoshop AI tools here.
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T HE R I S E  OF  

A R T I F I C I A L 
I N T E L L I G E N C E

With Photoshop updates now regularly featuring 
new AI tools, has image editing changed for 

the better, or should we be concerned?
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The new Sky Replacement 
feature in Photoshop is sure 

to delight and infuriate in equal 
measures. Employing Sensei – 
Adobe’s artificial intelligence 
technology – Photoshop will 
analyze the image, figure out 
where the sky is, and replace it 
for you.

Like any automated tool in 
Photoshop, Sky Replacement 
works brilliantly on some photos, 
but less so on others. The real 
question is not how well it works, 
though, but whether you think 
it’s right that a landscape photo 
should be enhanced in this way.

We’ve already seen a similar 
automated sky replacement 
feature in Skylum’s Luminar 4, 
and the newly released Luminar 
AI goes one further by letting 

Luminar 4 
was the first 
image editor 
to offer AI sky 
replacement, 
with Adobe 
Photoshop 
following 
soon after.

you drop distant scenery like 
mountains in the background 
of your photos. So whether we 
agree with it or not, AI is the new 
direction in image editing.

CHANGING SKIES
Sky replacement is something of 
a litmus test for AI editing. Digital 
manipulation has long been a 
bone of contention for landscape 
photographers. Replacing a sky 
may make a dull landscape look 
more appealing, but in a sense 
it also cheapens 
the image. Nothing 
can compare 
to capturing a 
glorious scene ‘in 
the moment’. But sky replacement 
isn’t a new concept: we’ve had 
the tools to do so for years. 

D I G I T A L  M A N I P U L A T I O N 
H A S  L O N G  B E E N  A  B O N E 

O F   C O N T E N T I O N



It’s just that it now takes mere 
seconds, and you don’t need to 
be a Photoshop whizz to do it. 
Now that it‘s easier and quicker 
than ever, it’s inevitable that the 
technique will be used more.

On the other hand, the idea 
that ‘things are easier than they 
used to be’ has been a constant 
complaint from traditionalists 
ever since the Box Brownie. Why 
shouldn’t amateurs be able to edit 
as effectively as professionals? 
In this sense, AI is a great leveller.

A COUPLE 
OF CLICKS
Perhaps the 
genuine landscape 
photo is a thing 

of the past. Never again can you 
look at a gorgeous scene from 
someone’s gallery without a 
nagging suspicion that it’s a fake.

For a genre that is supposed 
to be a celebration of the great 
outdoors, it’s a worrying direction. 
Think of all those dedicated 
photographers who’ve woken up 
early to catch the light, or traipsed 
back to the same spot time and 
again waiting for that perfect sky. 
More worryingly, this new tool 
might put off new photographers 
who are thinking of following 
the same path: why go to all that 
effort when you can get similar 
results with a couple of clicks?

In this sense, there’s a real 
danger that AI is changing the 

The Sky 
Replacement 

tool in 
Photoshop 

lets you drop 
in a new sky 
in seconds - 

choose from 
the library of 

skies or one 
of your own 

photos.

T H E R E ’ S  A  R E A L  D A N G E R 
T H A T   A I    I S  C H A N G I N G  T H E 

A C T   O F  T A K I N G  P H O T O S



act of taking photos, and the 
essential joys of the craft. An 
AI feature in Lightroom’s cloud-
based app even selects ‘your 
best photos’ for you, based on 
photographic principles. Replacing 
a sky is one thing – but if you’re 
letting a machine choose your 
keepers, you’ve arguably lost 
control of your photography.

GAME-CHANGING TOOLS
Aside from the moral debate, AI 
is powering some of the most 
exciting editing tools we’ve seen 
in recent years. Select Subject 
and the Object Selection Tool are 
both amazing time-savers, and 
the new Photoshop Neural filters 
look promising too. Then there’s 
Lightroom CC’s Sensei-powered 

Search, which is a game-changer 
for lazy keyworders. And before 
we get too worked up about Sky 
Replacement, it’s also worth 
thinking of those for whom it 
will be a godsend. For every 
landscape lover concerned 
about truth, there’s a jobbing 
real-estate photographer who 
just wants to make a nice quick 
photo to help their client sell 
their house.

As things 
progress at 
such a pace, it’s 
important to 
edit responsibly 
as well as 
creatively. This means not 
passing off a composite as an 
unedited competition entry; 

Lightroom 
CC’s Search 
function lets 
you easily 
find types 
of images 
without any 
need for 
keywording 
files - like a 
search for 
‘coast’ here.

A I  I S  P O W E R I N G  S O M E  O F  T H E 
M O S T  E X C I T I N G  E D I T I N G  T O O L S 
W E ’ V E  S E E N  I N  R E C E N T  Y E A R S



not retouching portraits too 
heavily or reshaping a person’s 
body unless they ask for it; 
and above all not manipulating 
documentary photos or any scene 
that purports to be genuine.

There’s a fine line between fun 
fakery and outright deception, 
and it’s not just artistic merit 
that’s at stake. The whole concept 
of truth in modern media, press 
and events is constantly called 
into question, and fake images 
play a big part in this.

A BADGE OF AUTHENTICITY
With this in mind, Adobe has 
introduced another new feature. 
Sky Replacement may grab the 
headlines, but this addition might 
quietly become more significant. 
The new Attribution Tool is part 
of Adobe’s Content Authenticity 
Initiative. It’s like an aeroplane 
flight recorder for your photos, 
an image-editing black box. The 

feature attaches 
a tamper-
proof history 
to a photo that 
shows exactly 
who created it, 

what edits have been made and 
whether more than one image 
has been composited together. 

Perhaps this will become proof 
of provenance for photographers. 
Short of handing over a raw 
file, before this it’s been hard to 
show that an image has not been 
manipulated. But now we can 
demonstrate that we were there, 
in that moment, and we captured 
a real scene.

The signs are promising for this 
new badge of authenticity. Adobe 
has brought several big names 
on board to collaborate on the 
feature, like The New York Times, 
Twitter, Microsoft, CBC and the 
BBC. The Content Authenticity 
Initiative could become a powerful 
way to combat the fake photos. 
In an age where nothing can be 
seen to be believed, it might 
just claw back a little faith in 
the veracity of the digital image. 
As a photographer first and 
a Photoshopper second, this 
sounds like a good thing.

These are the most interesting 
times for image editing we’ve 
seen in years, with AI placing 
professional results in the hands 
of the masses. Monotonous 
tasks can be sped up, images 
can be enhanced in seconds 
and everyday scenes can be 
completely reworked.

But as we explore these 
wonderful new tools, we should 
ask: is it more important that we 
make an eye-catching image, or 
one that feels real? For many of 
us, photography is not just about 
the results, but also the journey, 
and the path of least resistance 
may not always be the most 
rewarding route. •

Adobe’s 
Content 

Authenticity 
Initiative can 
help to prove 

whether an 
image is real 

or fake.

P H O T O G R A P H Y  I S  N O T  J U S T 
A B O U T  T H E  R E S U LT S ,  B U T 

A L S O   T H E  J O U R N E Y



T O P  1 0  A I  T O O L S 
I N   P H O T O S H O P

( A N D  1 0  W E ’ D  L I K E  T O  S E E  N E X T )

01 SELECT SUBJECT
This is without doubt 

our favorite of the AI tools in 
Photoshop. Simply go to Select 
> Subject (or click the button 
displayed at the top while using 
any selection tool): Photoshop will 
analyze your image and determine 
what the subject is, then make a 
selection for you. It’s especially  
brilliant with portraits.

In this video we’ll make use of 
Select Subject to quickly isolate 
the model, so we can fix the color 
temperature difference between 
the subject and the background.

B E F O R E

A F T E R WATCH THE VIDEO
https://bit.ly/3iwAct2



02 OBJECT SELECTION
Similar to Select Subject, 

Object Selection allows you to 
draw a box over part of your 
image, then Photoshop will 
analyze the contents and select 
the object within the box. It’s 
useful if your photo has more 
than one subject, or if you want to 
select an object other than your 
main subject. Watch the video to 
find out how we can use Object 
Selection to quickly isolate the 
foreground tree, then add a haze 
effect and a mono treatment. B E F O R E

A F T E R

WATCH THE VIDEO
https://bit.ly/3o4UHyi



03 SELECT SKY
This automated selection 

tool uses AI to recognize the sky 
in outdoor photos and isolate the 
area. It’s brilliant for balancing out 
skies with land below, as skies 
tend to be brighter.

Simply go to Select > Sky, then 
add a Curves or Level Adjustment 
Layer and use it to darken the 
area. In this video, we’ll look at 
how the command helps us pull 
extra detail and color out of 
a seemingly blown-out sky.

B E F O R E

A F T E R

WATCH THE VIDEO
https://bit.ly/3ixKnxQ



04 LIGHTROOM SENSEI SEARCH
This analyzes image content and recognizes the objects within, allowing you to 

search your entire image library for all kinds of things (like ‘water’ here). It’s like a perfectly 
keyworded library without the need to keyword anything. For now it’s only available in 
Lightroom CC, not Lightroom Classic.

05 NEURAL FILTERS
Under Filter > Neural 

Filters, this bold new feature 
houses an array of AI-powered 
filter effects and image-changing 
edits, from the Style Transfer 
filters here to the amazing 
Colorize filter, which adds a hand-
tinted color effect to black-and-
white photos. Adobe promises 
there’ll be regular updates and 
treats as the technology develops.



06 SKY REPLACEMENT
This is similar to the Select Sky command, but not only does it isolate the sky, it also 

lets you drop in a new one (either from the default library of skies, or one of your own sky 
images). Simply go to Edit > Sky Replacement. It’s very clever – it even adjusts the colors 
in the landscape to match the sky you choose.

07 CONTENT AWARE FILL
This has long been one of 

the best tools in Photoshop for 
removing objects from scenes. 
It does so by uses AI to analyze 
the image content around the 
area you want to fill, in order to 
match and rebuild the scenery. 
Sometimes the results can be 
slightly messy, but it usually just 
takes a few seconds of cloning 
to finish off.



08 FACE AWARE LIQUIFY
Found within the Liquify command (Filter> Liquify) this feature automatically 

recognizes faces and allows you to make adjustments to the positioning of features. 
You can add a subtle smile, enlarge eyes or tweak the shape of the face using a range 
of intuitive sliders. The results can look unnatural, but it’s fun for making caricatures.

09 ENHANCE DETAILS 
Something of a hidden 

feature, this tool analyzes 
your image and adds in extra 
detail for you. It can potentially 
crisp up details, improve color 
rendering and reduce artifacts. 
It’s more effective on high-ISO 
images, but often the changes 
are barely perceptible. Simply 
right-click a raw image in Camera 
Raw or Lightroom and choose 
Enhance Details.



10 AUTO TONE
The Auto Tone feature in Lightroom and Camera Raw now uses AI while fixing tones 

automatically. As such, it can analyze image content, determine how different objects are 
supposed to look, and apply a more nuanced level of toning to enhance the areas.

AUTO SENSOR REMOVAL | AUTO STRAY HAIR TIDY | AUTO SUBJECT SHARPENING | 
AUTO RE-CROP AND RE-FRAME | AUTO BACKGROUND BLUR | AUTO NOISE REDUCTION 
| SENSEI SEARCH IN LIGHTROOM CLASSIC | AUTO BRACES REMOVAL FROM TEETH  | 
AUTO EYE ENHANCEMENT | AUTO MOTION BLUR FOR CLOUDS AND WATER

1 0  A I  F E A T U R E S  W E ’ D  L I K E  T O  S E E  N E X T…



Transform treasured memories 
into memorable wall art.
Mounted under acrylic, framed, or as large-format photo prints. Made in Germany by people 

who love photography. We are the proud recipients of over 100 awards and recommendations! 

Simply upload your photo and create custom works of art – even from your smartphone.

WhiteWall.co.uk
Stores in London | Berlin | New York | Paris | Vienna | Zurich
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Available in both 
Lightroom and 

Photoshop’s Camera Raw 
filter, the Hue, Saturation 
and Luminosity tools within 
the Color Mixer box give you 
a fine degree of control over 
colors and tones in your 
images, giving you creative 
options whether you want 
to subtly alter a color or 
change it completely. Here 
we’ve made use of the Color 

Explore these invaluable 
tools in Camera Raw, 

and make stunning 
color shifts in photos

PRACTISE THE 
POWER OF 

COLOR MIXING

 DOWNLOAD THE PROJECT FILES HERE https://bit.ly/pho_119 ON YOUR PC OR MAC 

WATCH THE VIDEO
https://bit.ly/2NlwSWq

AFTER

the hue, saturation and 
luminosity of colors 
in the image, you can 
experiment with Camera 
Raw and Lightroom’s local 
adjustment tools, which 
enable you to change colors 
over a specific part of the 
image. We’ll progress to 
using those tools here as 
we create a vibrant multi-
colored backdrop for a 
photoshoot portrait.

Mixer tools to re-color the 
backdrop without affecting 
the subject.

This task takes mere 
seconds with a targeted 
Hue adjustment, and doesn’t 
require any complicated 
selections or cut-outs. 
You simply enable the Hue 
sampler, then drag over the 
backdrop to alter the color.

If you want to delve 
deeper into controlling 

BEFORE



1

THE COLOR MIXER PANEL
This panel houses some of 

Photoshop’s most useful 
color controls. Four tabs 

within the Color Mixer let you 
see the Hue, Saturation 

and Luminosity sliders, or 
all at once. Drag any slider 
to alter the different color 
ranges within the image in 

different ways. Hue affects 
the color itself, changing it to 
another; Saturation lets you 
make color ranges stronger 
or weaker; and Luminosity 
lets you make color ranges 

brighter or darker.

2

SET PANEL VIEWS
The dropdown at the top 
lets you switch between 

two views of color controls. 
Set it to HSL and you’ll see 
eight color ranges you can 

alter. Switch to the Color 
view to see Hue, Saturation 
and Luminosity sliders plus 

eight color circles. HSL is 
usually better for sweeping 

changes, while Color is 
useful for working on a 

specific color range.

31

2

3

ON-IMAGE CONTROLS
When the target in the 

Color Mixer Panel is toggled 
on, you can drag over the 
image to adjust the color 
ranges within. Here, for 

example, we can drag 
over the backdrop and 

transform the blue colors to 
another hue of our choice. 

Using the on-image tool 
is usually more effective 

than manually tweaking the 
sliders on the right. Not only 

is it quicker, it also lets you 
affect more than one color 

range at a time.



4

TARGET COLORS 
WITH RANGE MASK

Whenever you use a local 
adjustment tool, begin 

by defining the area you 
want to affect. Here we’ve 
dragged in from the corner 
with the Graduated Filter 
Tool, then altered Hue to 
create a color transition. 

Next, use Range Mask 
to restrict the effect to the 

background so it doesn’t 
affect the subject. Set 

Range Mask to Color then 
click to sample a color. 

(Hold Shift to select more 
than one color at a time.)

5

COLOR RANGES
The Color Mixer gives you 

control over eight different 
color ranges within the 

image. Here, altering Blues 
and Aquas lets us change 

the color of the background. 
This only works because 
there is no blue or aqua 
present in the subject, 

though. If the backdrop was 
orange or red, we wouldn’t 

be able to alter the hue 
without affecting the skin 
as well as the backdrop. If 
altering a color range has 

unwanted side effects, try 
local adjustment tools.

5

MAKE LOCAL 
COLOR CHANGES

The local adjustment tools – 
Graduated Filter, Radial 
Filter and Adjustment 

Brush – give you the option 
to selectively alter the hue 

in different areas of the 
image. They also let you 

target local saturation as 
well as the usual exposure 
controls. Simply define an 

area of the image using 
the tool, then go to the 
Hue control and drag to 

choose another shade. Here 
it lets us shift colors in the 

backdrop for a multicolored 

4
5

6



One of the main 
challenges with 

landscapes is in balancing 
out bright skies with darker 
landscapes, especially if – 
like here – the foreground 
is in deep evening shade. 
Editing a landscape like 
this, where the contrast 
between land and sky is 
too great, many of us might 
simply lift the Shadows and 
drop the Highlights. It’s a 
quick fix that may help to 
pull detail out of the lightest 

James Paterson shows how to target areas of a landscape 
with Photoshop tools and make powerful local adjustments 

A LITTLE LOCAL KNOWLEDGE

 DOWNLOAD THE PROJECT FILES HERE http://bit.ly/pho_119 ON YOUR PC OR MAC 

and darkest portions of the 
frame, but can also lead 
to an image looking over-
processed, almost HDR-like. 
Sometimes it’s better to 
take a targeted approach. 
By making local adjustments 
that are tailored to specific 
areas of the shot, the results 
can look more natural.

Here, we’ll look at how 
to make a series of powerful 
local edits using Adjustment 
Layers in Photoshop. We’ll 
isolate the sky (using the 

new Sky Selection Tool) 
and make it bolder, then 
select the land and perform 
a few edits to enhance the 
textures and boost contrast.

But it’s not just land 
and sky that can pose a 
challenge. Here, with the 
foreground and midground 
in deep shade, the two 
blend into one another. 
By separating out the 
foreground and midground 
with selections, we can 
subtly adjust each.

WATCH THE VIDEO
https://bit.ly/3o1D56g

BEFORE



01 ENHANCE THE SKY
Open the shot and 

go to Select > Sky. In the 
Layers Panel (Window >  
Layers), click the Create 
Adjustment Layer icon and 
choose Levels from the 
resulting pop-up menu. The 
selection will convert to a 
mask, allowing you to make 
a local adjustment to the sky. 
Drag in the black point to 
darken the sky.

02 BOOST THE LAND
Hold Ctrl/Cmd and 

click the thumbnail of the 
mask to load the sky as a 
selection, then go to Select 
> Inverse. Now the land 
is selected. Add a Levels 
Adjustment Layer. Drag 
both the black and the white 
points inwards, as shown, 
to up contrast, and tweak 
the midpoint to control 
the brightness level.

03 ADJUST THE 
FOREGROUND

Highlight the Background 
layer, then grab the Quick 
Selection Tool. Paint over 
the foreground rocks to 
select them. (Hold Alt and 
paint to subtract from the 
selection if the process goes 
wrong.) Add another Levels 
Adjustment Layer; use it to 
darken and add contrast to 
the foreground, as shown.



04 ADD HAZE
To differentiate 

the foreground from the 
midground, we’ll add some 
haze. Hold Ctrl/Cmd as you 
click the mask thumbnail 
of the Levels layer to load 
a selection. Go to Select > 
Inverse. Add another Levels 
Adjustment Layer and drag 
the output black point in 
to make the image appear 
more hazy.

05 MASK THE GROUP
Press Ctrl/Cmd+G to 

turn the Levels layer into 
a group, then hold the Alt 
key as you click the Add 
Layer Mask icon to add a 
black mask to it. Grab the 
Brush Tool and paint with 
white around the edges 
of the foreground rock to 
add a more subtle haziness 
to the distant scenery of 
your image.

06 DODGE AND BURN
Alt-click the New 

Layer icon, set the Blending 
Mode to Overlay and check 
the ‘Fill with…’ box, then 
paint with white or black 
to dodge and burn areas of 
the scene. Lighten the parts 
you want to emphasize, like 
the temples in this photo. 
Make any other local tonal 
adjustments you like to 
finish off the image.



In 17th century 
Holland, a trend 

emerged for larger-than-
life still-life paintings of 
flowers. Galvanized by 
the fledgling disciplines of 
botany and horticulture 
at the time, Dutch artists 
like Jan Brueghel the Elder, 
Ambrosius Bosschaert and 
Roelandt Savery painted 
bulging bouquets brimming 
with allegory. Impossibly 
overblown arrangements 
full of tangling stems and 
masses of overlapping 
blooms were typical pieces 
of work for the time. These 
collections of luscious art 
would go on to influence 
both painting and flower 
arrangement for centuries 
to come.

We’ll take inspiration 
from the Dutch Masters 
in this project to craft our 
own impossible flower 
arrangement. By holding our 
flowers in various positions 
over a series of frames, we 
can elevate the bouquet to 
a height that defies the laws 
of physics. 

Of course, this also means 
we can re-use the same 
flowers over and over again 

James Paterson takes inspiration from the Dutch 
masters to craft a towering flower arrangement 

IMPOSSIBLE BOUQUETS 

 DOWNLOAD THE PROJECT FILES HERE http://bit.ly/pho_119 ON YOUR PC OR MAC 

in several places, so we 
don’t necessarily have to 
spend hundreds of pounds 
at the florists to create 
our humongous bouquet. 
We can simply place the 
camera on a tripod then hold 
the flowers in place, firing 
off a series of shots until 
we have a variety of 
blooms to craft our 
arrangement. 

Once done, 
we bring 
our series 
of shots 
together in 
Photoshop. 
This is 
easier 
than it 
might look 
– we make 
selections 
of the 
flowers 
using the 
Magic Wand 
to knock out 
the backdrop, then 
combine our blooms 
piece by piece. We’ll take 
you through every stage, 
showing you how to get 
set up then build your own 
incredible bouquets.

WATCH THE VIDEO
https://bit.ly/3nYLZSk

BEFORE



THE SET-UP: SELF-RAISING FLOWERS

1 FLOWERS
The flowers we’re using 

here are a mixture of real 
and fake. The fake flowers 

are sturdier, and we can 
bend the stems to create 

eye-catching curves. But the 
real flowers will look more 
natural, of course, so it’s a 
good idea to use a creative 

mixture of the two.

4 EXTRA FLOWERS
To build up our bouquet, we 
hold our flowers above the 
vase and at various angles. 
This way we can construct 
our bouquet over a series 

of shots. Capture a range of 
flowers in lots of different 

positions, and try to 
visualize how they will look 

when combined later on.

2 VASE AND TABLE
In keeping with the look of 

the famous Dutch paintings 
of the 17th century, we 

used a large porcelain jug to 
hold the components of our 
impossible bouquet. A rustic 
wooden table complements 

the look. You may have 
items around the house that 

will work just as well.

5 CAMERA AND TRIPOD
We need to take a series of 
shots in perfect alignment, 

so a tripod is essential to 
keep the camera fixed 
throughout. We used a 

50mm lens here, which gives 
a pleasing angle of view 

without overly distorting 
the flowers. After focusing, 

switch to manual focus.

3 LIGHTING
Our scene here is lit with 

two studio flashes from a 
home studio kit – one on the 
backdrop, the other on the 

flowers. (You’ll find more 
details on the lighting on the 
next page.) If you don’t have 

studio flash you can use 
window light. Just make sure 

the light stays consistent.

6 WIRELESS RELEASE
A wireless trigger lets you 
fire your off-camera flash. 
If you don’t have one, you 
could set your flashgun to 
optical remote mode, then 
use your camera’s pop-up 
flash to trigger it instead. 
Alternatively, use a flash 

that is wirelessly compatible 
with your camera.

Prepare for a larger-than-life flower arrangement with studio lighting skills

2

5

4

6

1

3



01  USE A DARK BACKDROP
Prepare a dark backdrop – we used 

a grey roll of paper for ours here. Set up 
a table in front of the background for 
your flowers. Ideally you want to keep 
a little distance between the table and 
the background so that the light on the 
foreground doesn’t spill onto the backdrop.

03  LIGHT THE FLOWERS
Our key light is a studio head fitted 

with a softbox. The softbox is positioned 
to the left and above the flowers, and 
angled so that the light is directed across 
the front of the flowers. We’ve placed a 
reflector next to the light to prevent it 
spilling on to our dark backdrop.

02 LIGHT THE BACKDROP
Our background flash here is fitted 

with a snoot, which channels the light into 
a point. This results in a subtle spotlight 
effect on the dark background, which helps 
to give the scene an extra sense of depth 
and will create a nice natural vignette in 
the corners of your image.

04 SET YOUR EXPOSURE
Our camera is set to Manual mode at 

1/200 sec, ISO 100, aperture f/8. Set your 
exposure first, then adjust the strength of 
your lights to fit in with your exposure. You 
can adjust the strength of a flash either by 
altering the power output or simply moving 
it closer or further away.

STEP BY STEP: LIGHT THE FLOWERS



STEP BY STEP: BUILD YOUR BOUQUET

01 LOAD INTO LAYERS
Navigate to the photos 

you want to use in Bridge, 
then hold Ctrl/Cmd and 
click on each to highlight 
them. Next up, go to Tools 
> Photoshop > Load Files 
Into Photoshop Layers. 
This will load all the images 
you’ve selected into a 
single document, for you 
to construct your collection 
of flowers.

02 ARRANGE THE STACK
Choose one frame 

to act as a base for all the 
others, and drag it to the 
bottom of the stack. Think 
about how each flower will 
fit in, and drag the layers 
with the flowers you’d like to 
appear at the front of your 
bouquet to the top of the 
stack. Once done, hold Alt 
and click the eye icon of the 
lowest layer to hide the rest.

03  ISOLATE THE FLOWER
Highlight and reveal 

the layer above the bottom 
layer, then grab the Lasso 
Tool and drag around the 
extra flower to make a 
loose selection of it. Next, 
grab the Magic Wand and 
check Contiguous in the tool 
options. Hold Alt and click 
on the parts of the backdrop 
that are within your initial 
selection to exclude them.



04 PAINT ON THE MASK
Once you have isolated 

the extra flower with a 
selection, click the Add Layer 
Mask icon. Next, highlight 
the Layer Mask thumbnail, 
zoom in, and paint black over 
any parts you want to hide, 
or paint with white to reveal 
flowers in the shot. Make 
sure you hide any fingers 
(or tongs) holding the stems 
of your flowers.

05 GO THROUGH 
THE LAYERS

Reveal the next layer up, 
then select and mask just 
as before. Continue in this 
way up through your layer 
stack to gradually build up 
your marvellous bouquet. 
If you need to, you can 
shift the positions of layers 
slightly to complement 
your composition of 
your final product.

06 TIDY THE COMPOSITE
Once all of your layers 

have been masked and 
combined as you want, make 
a new empty layer on top of 
everything. Grab the Clone 
Tool and set it to ‘Sample 
All Layers’ in the options, 
then use it to tidy any gaps 
or rough patches in your 
composite. Make any final 
tonal changes you like to 
complete the composite.

STEP BY STEP: BUILD YOUR BOUQUET



If you’d like to watch the  
complete course now, get the 
app from the Apple App Store

This issue, learn how to 
make slideshows to show 
off your best photos

LEARN LIGHTROOM TODAY!

LIKE THIS? NOW AVAILABLE ON 
THE APPLE APP STORE BIT.LY/TYLRAPP

BUY
NOW!

WATCH THE VIDEO
https://bit.ly/392bE88



     

ESSENTIALS
Your quick-start guide and reference  

to image editing in Photoshop

If you’re relatively new to editing in 
Photoshop, or you just don’t know 

where to begin, then this section is the best 
place to get started. Over the next 10 pages, 
you’ll find an overview of the different versions 
of Photoshop available; a breakdown of the 

typical image-editing workflow in Photoshop; 
an overview of raw file editing; a guide to the 
six most useful layers; and a glossary of the 
most useful shortcuts. This guide condenses 
most of the tools and techniques you’ll use 
every time you import a new roll of pictures.



CREATIVE CLOUD PLANS 
CHOOSE THE PLAN WITH THE COMBINATION OF TOOLS AND STORAGE YOU NEED

Photography Plan • 20GB Photography Plan • 1TB

Best for Traditional desktop users Cloud and desktop

Price per month £9.98/$9.99 £19.97/$19.99

Photoshop CC

Lightroom CC

Lightroom Classic

Lightroom Mobile

Cloud storage 20GB 1TB

Notes

If you want Photoshop, 
you need the regular 

Photography Plan – you 
also get Lightroom Classic

The same as the Photography 
Plan, but with 1TB storage. 
Existing users are offered 

a discount for the first year

Lightroom CC Plan Lightroom Mobile Premium

Best for Cloud fans Mobile-only users

Price per month £9.98/$9.99 £4.49/$6.49

Photoshop CC

Lightroom CC

Lightroom Classic

Lightroom Mobile

Cloud storage 1TB 100GB

Notes
With this plan you get the ‘new’ 
Lightroom CC and 1TB storage – 

but not Photoshop

This plan is for smart devices 
only. The Lightroom Mobile 

app is free, but the ‘premium’ 
version is an in-app purchase



Lightroom CC combines 
professional image-
processing tools with 

asset organizing. It keeps all its 
images online in the Creative 
Cloud, with advanced image 
search capabilities.

Lightroom Classic 
offers editing and 
organizing tools, but 

you can only store images on 
your computer.

LIGHTROOM CC
FROM £9.98/$9.99 PER MONTH  
WINDOWS, macOS

LIGHTROOM CLASSIC
FROM £9.98/$9.99 PER MONTH  
WINDOWS, macOS

Lightroom Mobile is 
the lightweight iPad, 
iPhone and Android 

version of the application, 
integrated with Lightroom 
CC. You can use Lightroom 
Mobile on its own for free, 
or use the Premium In-App 
Purchase to access the Adobe 
Creative Cloud. This enables 
you to create a collection 
of photos on your desktop 
copy of Lightroom, and sync 
them via the Creative Cloud 
to Lightroom Mobile on your 
portable devices. You can also 
get Lightroom Mobile via any 
Photography Plan.

LIGHTROOM MOBILE
FREE (PREMIUM: £4.49/$6.49 PER MONTH)
IPHONE, IPAD, ANDROID 

Photoshop is the software of choice for most professional 
and non-professional photographers. Beyond the standard 
photo-editing features, it boasts a vast array of more 

creative tools and filters. Layers are one of the key differences 
between Photoshop and Lightroom. They enable you to mask 
out selected parts to build up increasingly sophisticated images.

PHOTOSHOP CC 
FROM £9.98/$9.99 PER MONTH WINDOWS, macOS 

Elements is the consumer variant of Photoshop, and 
contains many of its key tools and features within a 
simplified interface. It’s limited, but it does provide access 

to layers for those who have switched to a Lightroom workflow.

ELEMENTS 15 £79.99/$99.99  WINDOWS, macOS



Adobe Shape enables 
you to turn photos and 
sketches into beautiful 

vector shapes for use in your 
designs or artwork. The app 
smooths out jagged edges in 
images, resulting in gorgeous 
vectors that are endlessly 
scalable, just as if you’d drawn 
them by hand with the Pen tool. 
Make a shape with the mobile 
app and the next time you open 
Photoshop on your desktop, the 
shape will sync to your Library. 
Drag it in to any document to 
add color and make further 
adjustments.

ADOBE SHAPE
FREE
IPHONE, IPAD, ANDROID 

Adobe Brush enables 
you to make your 
own custom brushes 

from photos or sketches for 
use in Photoshop, Illustrator 
or the Sketch app. The most 
successful subjects are usually 
those that can be easily 
isolated, such as a splash 
against white, or a leaf against 
the sky. You can capture objects 
for your brush tips using your 
device’s camera, choose from 
your camera roll, or use your 
Creative Cloud library. Once 
captured, you can then fine-
tune the look of the tip and 
apply brush settings.

ADOBE BRUSH
FREE
 IPHONE, IPAD, ANDROID 

Mix enables you to merge two photos together 
to create a composite image. It offers a simplified 
compositing process that makes it easy for beginners 

to start combining an object from one image with a background 
from another. You can then send the composite to Photoshop 
for further edits. If you like, you can also use Mix to edit a single 
image. It offers a few simple tonal adjustments and more 
complex edits such as Content-Aware Fill.

If you ever need help 
selecting coordinated colors 
for your designs, try using 

Adobe Color. It enables you to create 
color themes from photos taken on 
your mobile device. This could be 
anything from a scene in your local 
park to a famous painting. So if you 
come across an inspirational scene, 
capture the colors and save them.

ADOBE PHOTOSHOP MIX
FREE IPAD, ANDROID

ADOBE COLOR
FREE IPHONE, IPAD, ANDROID 



As the name suggests, this app enables you to paint 
freehand using a selection of brushes, colors and other 
tools. However, Sketch is more than just a painting 

app. It also enables you to connect with like-minded creatives, 
so you can follow artists and see their work updating. Once 
you’re done sketching the image on your iPad, you can upload 
to the Sketch community, or continue working on the image 
in Photoshop CC. You can also bring in brushes made with 
Adobe Brush, and for those who can’t paint, there’s an option 
to overlay images so you can trace over a photo. Sketch is 
compatible with Adobe’s pen and ruler hardware, Ink and 
Slide, but you can get great results with your finger.

Fix is a retouching app 
for altering portraits and 
fixing marks or blemishes 

in your photos. Intelligent facial 
recognition locks onto eyes, lips 
noses and chins, making it easy to 
tweak a smile, tuck in a jawline or 
enlarge eyes, should you wish.

ADOBE PHOTOSHOP SKETCH
FREE IPAD

PHOTOSHOP FIX
FREE  IPAD 

If you’re a designer 
who wants to build 
a quick layout for a 

web or print page, then Comp is 
the ideal place to start piecing 
ideas, images and text together. 
You can draw common design 
elements such as text or image 
boxes with quick gestures. For 
example, a couple of squiggly 
lines with a dot makes a 
header, and a cross makes an 
image box. It makes it easy to 
mock up a layout in seconds. 
You can then add words and 
graphics. The app even spits 
out a Photoshop, Illustrator or 
InDesign document.

ADOBE COMP CC
FREE IPAD

Behance is the online 
social space for 
creatives to share 

and showcase their portfolios, 
connect with one another, 
and find work. With work 
from the best photographers, 
digital artists and designers 
out there, it’s also a great 
place to find inspiration for 
a new project. If you’re a 
Creative Cloud subscriber you 
can set up a Behance page in 
minutes. The Behance app 
for iOS devices enables you to 
manage your page, while the 
Creative Portfolio app provides 
a polished portfolio.

BEHANCE 
CREATIVE PORTFOLIO
FREE IPAD, IPHONE
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The image-editing process begins as 
soon as you’ve transferred your photos 

from your memory card to your computer.
The first stage is to begin sifting 

through your pictures to discover which are 
the keepers. The image organizer that comes 
with Photoshop is ideal for this task. Adobe 
Bridge has controls for keywording, rating and 
filtering your images, and there are handy tools 
for batch renaming files, creating panoramic 
stitches, making contact sheets and more.
        Launch Adobe Bridge and navigate to a 
folder containing new images. Use the cursor 
keys to quickly flick through the images and 
click below a thumbnail to add a star rating, or 
use the keyboard shortcut Cmd/Ctrl+1-5. You 
can then filter your photos by the star rating to 
group the ones you want to work on.

   The next step is to open the shots from 
Bridge into Adobe Camera Raw. ACR is the best 
place to make initial changes to your images 
to boost tones and correct any problems with 
exposure and so on. It doesn’t enable you 
to combine images – you’ll use Photoshop 
for that – but it does enable you to make 
the kind of edits photographers need.
      In Photoshop, you can further refine the 
image with layers and adjustment layers, which 
offer a much more flexible way of working than 
ACR. Once you’ve finished, it’s time to share 
it with an audience. Go to File>Save, and your 
image will be saved as a Photoshop document 
(PSD). This keeps all the layers intact, which 
means you can go back and retweak the image 
at a later date. However, PSD files are large 
and can take up lots of hard drive space. If you 
want to share your images online or via email or 
social media, save them as JPEGs.

THE IMAGE-EDITING WORKFLOW
Manage your photos from capture to output in three stages
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THE BASICS OF RAW PROCESSING
Discover how to process your raw files to perfection

The latest version of the raw file 
processor included with Photoshop is so 

powerful that most photos can be processed 
entirely in the raw processor, with no need for 
further editing in Photoshop. And by making 
your adjustments in Adobe Camera Raw, 

rather than in Photoshop, you’ll ensure the 
best possible image quality, because raw files 
contain more picture information than bitmap 
images such as un-layered PSDs and JPEGs. 
Here’s our reference to the features you’ll 
use the most in the Basic panel.

THE BASIC 
PANEL IN ACR

TEMPERATURE
Use this slider to warm 
or cool an image if the 
White Balance tool fails 
to correct a color cast

CONTRAST 
Makes light pixels brighter 
and dark pixels darker

CLARITY
Controls the amount 
of midtone contrast

SATURATION 
Controls the overall color 
intensity of the image

TINT 
This slider enables you to 
correct a green or magenta 
cast, again, if the White 
Balance tool fails

HIGHLIGHTS 
Controls the brightness 
of the lightest pixels

EXPOSURE 
Controls the overall 
brightness of the image

BLACKS 
Sets a point on the tonal 
range at which pixels 
should be pure black

SHADOWS 
Controls the brightness 
of the darkest pixels

WHITES 
Sets a point on the tonal 
range at which pixels 
should be pure white

VIBRANCE
Adjusts the intensity of 
the less-saturated colors



SIX ESSENTIAL LAYERS FOR PHOTOS
The six most frequently used Photoshop layers for image 
editing, and how to use them to improve almost any photo

Photoshop has many types of layers 
and adjustment layers available, but 

there are six that you’ll find you need to use 
again and again. Learning how they should be 

used may seem a little daunting for beginners, 
but once you’ve got to grips with them, you’ll 
find they play a part in the creative process of 
almost every image you make.

02 CURVES
Curves is one of the most powerful 

adjustment layers. An S-shaped curve 
brightens the highlights and darkens the 
shadows, resulting in extra contrast. Create 
a Curves Adjustment Layer and click the 
middle of the diagonal line to add a central 
control point. Drag down on the lower part 
of the line and drag up on the upper part of 
the line to improve image contrast.

01 LEVELS
This should be the first layer you add 

to an image, because it fundamentally alters 
the tonal range of the entire image. Create 
a Levels Adjustment Layer, drag the Black 
point slider inwards until it touches the left-
hand edge of the histogram, and drag the 
White point slider inwards to the right-hand 
edge. This remaps the tones of the image to 
make more of the available tonal range.

03 HUE/SATURATION
This adjustment layer is best used 

for altering the intensity and brightness 
of individual color channels in an image – 
greens and blues in landscapes, for instance. 
Create a Hue/Saturation Adjustment Layer, 
click the Master menu and choose the color 
channel you’d like to adjust. Small changes 
are usually the most effective.



BEFOREAFTER

06 SELECTIVE SHARPENING
Once all other adjustments have 

been made, you need to sharpen the image 
for output. The traditional way is to create a 
merged layer at the top of the stack, apply 
Unsharp Mask, then paint on the mask to 
remove the sharpening from those parts 
of the image you want to remain soft. 
However, the Sharpen tool enables more 
control over the process by enabling you to 
build up the effect by brushing repeatedly 
with a low opacity brush. Create a new blank 
layer, select the Sharpen tool, tick Sample All 
Layers and set a Strength of 50% or lower.

05 DODGE AND BURN
One of the best ways to enhance a 

photo is by lightening or darkening selected 
areas of the image. This can be done with 
the Dodge and Burn tools, but rather than 
use them directly on the image, a separate 
grey layer gives you greater control. To 
create a Dodge and Burn layer, hold down 
Alt and click the Create a new layer icon in 
the Layers panel. Give the layer a name, 
then choose Mode: Overlay. Check Fill with 
Overlay-neutral color and click OK. Now use 
the Dodge and Burn tools (with Range set to 
Midtones) to work on the new layer.

04 HEALING LAYER
Most photos contain unwanted 

marks or blemishes. The Spot Healing Brush 
tool is effective at removing these. The best 
way to apply the healing is on a new blank 
layer, so that you can easily tone down or 
remove selected healing work later without 
having to start from scratch because you 
healed directly on the background layer. 
To do this, create a new blank layer, choose 
the Spot Healing Brush tool from the Tools 
panel and tick Sample All Layers on the 
Options bar, then continue as normal.



D
Reset the foreground and background colors 
to black and white

ALT+[SCROLL WHEEL]
Zoom in or out of the image

[ OR ]
Resize the brush tip

CMD/CTRL+SHIFT+ALT+E
Create a merged copy of all the layers in the 
layer stack

SHIFT+[ OR ]
Cycle backwards or forwards through the 
layer blend modes

SPACE BAR
Temporarily switch the current tool to the Hand 
tool, for moving around the image while zoomed in

CMD/CTRL+[LAYER MASK]
Load the currently active layer mask as 
a new selection

ALT+[EYE ICON]
Switch off the visibility of all other layers in the 
layer stack, for before-and-after comparisons

CMD/CTRL+T
Activate the Free Transform tool

CMD/CTRL+I
Invert the color of a layer mask to black

SHIFT+[LAYER MASK]
Disable the effects of a layer mask

CMD/CTRL+J
Duplicate the current layer

X
Switch the foreground and background 
color swatches

14 keyboard shortcuts that will massively improve your 
speed and efficiency while working in Photoshop

14 ESSENTIAL 
KEYBOARD SHORTCUTS

CMD/CTRL+Z
Undo the last change made to the document. 
Works multiple times

.
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